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INTRODUCTION 

   
Hello and thanks for downloading my ebook! 
 
First off a little bit about myself… originally from Leicestershire, UK I moved to Ireland back in 2007 
with my other half and a suitcase!  
 
After a few years in Ireland, not to mention the 18 years in the UK, of working in a variety of 
administrative roles for other people, I decided to take the plunge and start my own business in 
2010. 
And that’s when OutofhoursAdmin was born; a virtual assistant service providing remote admin 
support to businesses throughout Ireland and the UK. 
 
After receiving numerous questions about MS Office from clients, I decided to share my answers in 
the form of tutorials which I post regularly on my blog.  
 
This ebook is a compilation of all my tutorials from my blog for Microsoft Word 2007 put together in 
a handy guide which I hope you will find useful. 
 
And, don’t forget if you want an extra pair of hands to help with any of your administration, get in 
touch by emailing me at sharon@outofhoursadmin.ie or you can connect with me on Facebook, 
LinkedIn or subscribe to my YouTube channel. 
 
Thanks, 
 

Sharon 
 
 
 
 
 
 
 
  

http://www.outofhoursadmin.ie/
http://www.outofhoursadmin.ie/category/blog/
mailto:sharon@outofhoursadmin.ie
https://www.facebook.com/OutofhoursAdmin/
http://ie.linkedin.com/in/outofhoursadmin
http://www.youtube.com/user/outofhoursadmin/videos
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HOW TO START (& MAINTAIN) A PRODUCTIVE DAY 
 
I’m not a morning person!  I admit that I struggle for the first couple of hours of the day but being a 
Virtual Assistant means I’m lucky enough to work from home and schedule work in to fit around my 
peak times.  We’re all different and our productivity levels peak at different times during the day (& 
night) yet the majority of us end up working against our body clock, struggling to be productive at 
the wrong time. 
 
If your working day isn’t flexible enough and you have to work during “off peak” times, how can you 
maintain the same level of productivity that you have during your peak time?  Listed below are a few 
tips to get you started:- 
 

 SLEEP First things first, make sure you get adequate sleep, again everyone is different – 
some people can manage on only 5 hours, others prefer 7-8.  I know if I have less than 7 
then I’m like a tetchy two year old.  However many hours you know you need to wake up 
feeling refreshed, make sure you get that amount! 

 

 DRINK Wipe the smile off your face I’m not talking about alcoholic drink!  I’m talking about 
water!  Drink plenty of water throughout the day & keep yourself hydrated. 

 

 EAT Try to eat little and often to keep your energy levels up – it’s no good not having 
breakfast then having a huge lunch to make up for it.  How many times have you gone out 
for lunch, eaten more than usual then just want to curl up & sleep?  Little and often is the 
key! 

 

 BREAK Taking regular breaks will help you to re-focus.  Try taking a 10 minute break every 
hour – it may sound like you’ll get nothing done as all you’re doing is having breaks, but 
you’ll be surprised at how productive you’ll be. 

 

 EXERCISE I admit this is one area that I struggle with – I’m nice and warm in my office and 
the thought of going for a walk or doing any form of exercise fills me with discontent!  
However, going for a brisk walk during the day will refresh you and you’ll be more focused 
when you return.  I’ve now started going for a 20 minute walk in the morning before I start 
my work and it’s amazing how much more energised I feel afterwards (especially as I’m not a 
morning person!) 
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MS OFFICE 
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WHICH VERSION OF MICROSOFT OFFICE DO I HAVE? 
 
I’m often asked how to do things in Excel or Word by clients, which is fine (that’s what I’m here for). 
My first question is always “what version of Office do you use?” to which the response is usually “I 
have no idea, where does it tell me that?”.  So this short guide is to show you how to find it… 
 
The following screen shots are all from using Excel, however the same would also apply if you were 
in Word. 
 
Click on the Microsoft Office button in the top left corner of the screen, then click Options, go to 
Resources… 
 

 
 
Alternatively, you can click the start button on your desktop & type Microsoft into the search bar, 
which should then list all Microsoft programs along with the version that you’re using. 
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HOW TO SET YOUR DEFAULT LANGUAGE 
 
I used to find it quite frustrating that my spellchecker would underline words which I knew were 
spelt correctly, it’s because my language settings were automatically defaulted to US English, so I 
changed it. 
 
You can of course change the settings in each application of MS Office individually; this tutorial will 
show you how to do the whole lot in one go. 
 
Click on the Start button, select All Programs… 
 

 
 

Then choose Microsoft Office, Microsoft Office Tools, and click on Microsoft Office 2007 Language 
Settings… 
 

 
 

On the right side will be a list of enabled editing languages, the language you want needs to be in 
this list, if it isn’t you can add it from the languages available list on the left hand side.  This is where 
you can set your default language – in my case I want it to be English (UK). Select your language as 
the primary editing language and click OK… 
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You should then see this message which is basically warning you that you are changing the primary 
language… 
 

 
 

…and that’s it! All of your Microsoft Office programs will now be defaulted to your primary language. 
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HOW TO CUSTOMISE YOUR RECENT FILES LIST 
 
It’s always handy to have your most recent documents displayed at the top of the list when you click 
into Recent Documents, however you can customise this list so it contains as many documents as 
you wish.  
 
Click on the Microsoft Office Button, select Word Options, click on Advanced from the menu on the 
left, scroll down to the Display section, change the number of the Recent Documents and click OK… 
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WORD TUTORIALS 
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QUICK KEYBOARD TIPS 
 
Below is a list of keyboard shortcuts for Word, most of which I would use on a regular basis. The 
majority of them you probably already know of however there are a couple of shortcuts used for 
formatting which may be useful to know. 
 
Ctrl + A  Selects the whole document 
 
Ctrl + B  Makes the selected text bold 
 
Ctrl + C  Copies the selected text 
 
Ctrl + D  Displays the Font dialog box 
 

 
 
Ctrl + E  Toggles the paragraph between centred and left aligned 
 
Ctrl + F  Displays the Find dialog box 
 
Ctrl + G  Displays the Go To dialog Box 
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Ctrl + H  Displays the Replace dialog box 
 
Ctrl + I  Makes the selected text italic 
 
Ctrl + J  Toggles the paragraph between justified and left aligned 
 
Ctrl + K  Displays the insert a Hyperlink dialog box 
 
Ctrl + L  Left aligns a paragraph 
 
Ctrl + M Indents a paragraph from the left 
 
Ctrl + N  Creates a new default document 
 
Ctrl + O  Displays the Open dialog box 
 
Ctrl + P  Displays the Print dialog box 
 
Ctrl + Q  Removes paragraph formatting 
 
Ctrl + R  Right aligns a paragraph 
 
Ctrl + S  Saves the active document 
 
Ctrl + T  Creates a hanging indent 
 
Ctrl + U  Underlines the selected text 
 
Ctrl + V   Pastes copied or cut text into the document 
 
Ctrl + W  Closes the active document 
 
Ctrl + X   Cuts the selected text 
 
Ctrl + Y   Repeats the last repeatable action 
 
Ctrl + Z   Undoes the last action 
 
All of these shortcuts can be viewed by hovering over the relevant icon in the task ribbon. 
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So there you have the most basic shortcuts for formatting Word. 
 
Happy typing! 
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HOW TO CUSTOMISE PROOFING OPTIONS 
 
As a virtual assistant one of the things I get to do a lot of is type… whether it's reports, pages of a 
book, presentations, you name it I type it! 
 
I've never been a huge fan of Word – I'm more of a spreadsheet kind of girl, but I have to admit that 
Word 2007 has changed me!  Gone are the endless drop-down menus from the 2003 version that 
you had to trawl through to find things… 
 

 
 
Instead, Microsoft has its own button where you can customise everything to your hearts content.  
This button is located in the top left corner of the screen and is visible the whole time an application 
is open. 
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When you click on the Office Button, it will bring up a menu where you can choose print, save, open 
etc – click on the Word Options button in the bottom right corner. 
 

 
 
This opens up a menu for you to go through and customise everything you want to from the colour 
scheme of the actual ribbon to how often you want the auto-recover to save the document.  I've 
changed the colour scheme for all my Microsoft applications to black, which is why my screenshots 
may look slightly different to yours!  This short guide focuses purely on the Proofing options. 
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Here, you can customise how you want the spellcheck and autocorrect to work.  If you click on 
AutoCorrect Options, it brings up a handy little menu where you can add words that you know you 
always spell incorrectly.  For example, if you know that you always type wieght instead of weight, 
you can add this to the autocorrect so it will automatically change it to the correct spelling.  One of 
the typos I'm always making is "the" – I'm forever typing "teh" instead (seems my fingers can't keep 
up with my brain).  So, I've set up Word to automatically correct this, instead of flagging it up and me 
having to change it at the end. 
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You can also change the formatting as you type.  Fractions are a good example of this – when you 
type in 1/2 it will automatically change to the fraction half. 
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I know everybody's different, so have a play around with the different options and customise it the 
way you want it.   
  

 

Ninja Note: 
Remember that everything 
you change in here will 
automatically apply to ALL 
Word documents you open or 
create from now on! 
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HOW TO USE FORMAT PAINTER 
 
There is an icon on the toolbar in MS Office applications that is a little gem. 
 
It saves so much time when typing documents.  It's the Format Painter icon. 
 
What does it do? 
Basically it does exactly what it says… it paints (copies) the format of a selected area and applies it to 
another (hover over the icon and it will give you a description of what it does). 
 

 
 
Where do I find it? 
You'll find this icon in the Home section of the ribbon, in the Clipboard group. 
 

 
 
Below is an example of what it can be used for in Word: 
 
You have a document which you've been adding to on a regular basis – maybe pages of a book or a 
guide that you're typing out.  You've been pasting quotations or paragraphs from other sources 
which have different formats to the rest of your document.  If you highlight a section of the 
paragraph that you want to keep the formatting for, click on Format Painter and you'll see the 
mouse cursor has changed slightly – it now has a paintbrush next to it. 
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Highlight the section of text that you want to change, let go and it will automatically copy the format 
of the original text that you selected. 
 

 
 
If you have multiple sections of text that you want re-formatted, highlight the formatting you want 
to keep, double-click the Format Painter icon, highlight the first section of text you want to change, 
then highlight the 2nd section and so on. 
 
Personally, I think Format Painter is a tool that is really under-used, which is a shame as it’s so handy 
for quick formatting. 
 
 
 
 
 
 
 
 
 
 
  

 

Ninja Note: 
To close Format Painter either 
press the Escape key or click 
on the Format Painter again. 



 

WORD TUTORIALS How To Delete a Page Page | 20  
 

 

MS Word 2007 Tutorials | OutofhoursAdmin 

HOW TO DELETE A PAGE 
 
A client asked me a very good question the other day – she wanted to know if there was a button in 
Word called Remove a page. There’s one on the ribbon called Insert a Blank Page so it’s only fair to 
assume there’s one for the opposite, right? Wrong!  There isn’t! But there is an easy way to delete 
pages, below is my quick guide on how to do this. 
 
The first thing to do is turn on the Show Paragraph Marks which is located in the Paragraph section 
of the Home tab… 
 

 
 
This will make all the spaces, returns and any other formatting symbols appear as in the example 
below… 
 

 
 
Click on the blank page that you want to remove, making sure that your cursor is positioned in front 
of the paragraph mark… 
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Press backspace or delete and that page will disappear moving your cursor back to the end of the 
previous page (you might need to press delete a few times depending on how many “returns” were 
pressed on the blank page)… 
 

 
 
Then you can turn off the Paragraph marks by clicking the Show/Hide Paragraph Marks button again 
in the Home tab on the ribbon… 

 
And that’s it. 
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HOW TO QUICKLY DELETE WORDS 
 
This quick tip might end up being one of those little gems that you didn’t know about and I promise 
it will save you time! 
 
How do you normally delete words when typing in MS Word? Do you usually press backspace or the 
delete key several times (or hold it down continuously) until the words are gone? 
Did you know there is a quicker way? 

 
All you have to do is press Ctrl 
 
Ctrl+Delete deletes text from where the cursor is to the end of the next word, e.g. if you want to 
delete 3 words to the right, press Ctrl+Delete 3 times. 
 

 
 
Ctrl+Backspace deletes words to the left of where the cursor is. 
 

 
 
And that’s it! 
A quick and easy way to carry out mass deletions when editing documents. 
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HOW TO OVERTYPE TEXT 
 
Many of you have probably read the title and thought what am I talking about? Surely you highlight 
the text and start typing, right? Well any of you who currently use, or have previously used Word 
version 2003, will know that by pressing Insert on your keyboard will change to overtype mode.  In 
later versions, however, this key no longer works… unless you know how to switch it on! 
 
Right click the status bar (at the bottom of the screen), and click Overtype… 
 

 
 
This will display the Insert mode on the left side of the status bar. If you click on Insert… 
 

 
 
…it will change to Overtype mode and you can then overtype existing text.  Click the word Overtype 
when you’ve finished and it will change back to Insert mode… 
 

 
 
Pressing Insert on your keyboard will still have no effect, however if you want the insert key to turn 
Overtype on & off, you have to set it up as your default.  To do this, click on the Microsoft Office 
button, and open up the Word Options… 
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Click on Advanced, and in the Editing Options section tick the box for Use the Insert key to control 
overtype mode, then press OK… 
 

 
 
This means that you can now go back to using the Insert key on your keyboard to control overtyping.  
Remember though that any changes you save within the Word Options menu will now be set for any 
future documents that you create or open. 
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HOW TO COUNT WORDS 
 
This post takes me back to my school days (a loooong time ago!), when I had to submit an essay of 
no more than 500 words etc.  Back in those days we had to write essays out (yes with pen & paper!), 
and I remember spending many an evening manually counting the words contained in the pages… 
those were the days! 
 
Thankfully, there is a much simpler way of counting words now using Word.  It’s especially useful for 
anyone who schedules their tweets as, I’m sure you all know, Twitter has a limit of 140 characters.  
Type out your tweets in Word first so you can see how many characters you’re using, then copy & 
paste them into Twitter. 
 
Whenever you highlight sections in Word, whether it’s a couple of words, lines or paragraphs, you’ll 
notice a word count automatically appears in the toolbar at the bottom of the screen… 
 

 
 
For example the above picture shows there are 26 words highlighted. 
 
If you don’t see the word count in the bottom bar, it means it’s switched off.  In order to switch it on, 
right click your mouse anywhere on the bottom toolbar, and select Word Count… 
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But what about spaces? Obviously Twitter measures the number of characters (including spaces), 
and not only words. 
 
Well, if you click on the Word count, it will bring up a dialog box… 
 

 
 
You’ll see that everything is counted! 
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HOW TO MOVE PARAGRAPHS QUICKLY 
 
I often get asked to make Word documents look more "presentable", and this usually means having 
to move paragraphs of text around.  The most obvious way to do this would be to highlight the text, 
cut and paste to where you want it positioned. However… there is a quicker way! 
 
Firstly highlight the text / paragraph that you want to move. A quick way of doing this is to move the 
cursor over to the far left of the text until it changes shape to a white block arrow pointing 
diagonally up to the right… 
 

 
 
Click and drag down to highlight the lines of text in one go… 
 

 
 
Next, press Shift+Alt+the up or down arrow keys… 
 

 
 
…and this will move the selected text up or down to where you want it… 
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The good thing about doing it this way is that you see a live preview of what your new layout looks 
like without having to cut, paste & then undo if you don't like it. 
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HOW TO INSERT A CONTENTS TABLE 
 
Anybody who has ever typed a large document in Word will know how invaluable a Contents Page is, 
and I don't mean the page that you manually type out then have to keep changing the page numbers 
as you add more & more to the pages!  I mean the automated one that is a feature in Word 2007.  It 
is surprisingly simple to create and keep updated, below is a guide on how to do this. 
 
To start building your Contents Page, you need to apply heading styles to the relevant titles within 
your document.  To do this, highlight the relevant text and click on the Heading you like in the Styles 
section on the Home tab. 
 

 
 
For example, the document below shows the name of the chapters and their subheadings with the 
Headings 1 and Headings 3 styles applied… 
 

 
 
Place the cursor at the point where you want the Contents Table to be, go to the References tab on 
the ribbon, and click on Table of Contents… 
 

 
 
A drop down menu will appear showing examples of different styles of Contents Pages; choose 
which one you prefer… 
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If you want to edit the actual Contents Page before inserting it, e.g. if you don't want to show page 
numbers etc, click Insert Table of Contents… 
 

 
 
This will open a dialog box where you can customise the table to your own preferences… 
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And that's it; a new Contents Table will appear… 
 

 
 
If you make any changes to the document at any stage, for example another 2 pages of text is added 
thereby throwing all the page numbering out, you can easily update the Contents Table in 2 clicks!  
You can either right click anywhere within the table and choose Update Field… 
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Or, click on Update Table in the Table of Contents section in the References tab on the ribbon… 
 

 
 
Whichever way you choose, a dialog box will appear asking if you want to update the page numbers 
only or the entire table. Choose which one you want to do and click OK… 
 

 
 
And that's it! A quick and simple way of inserting and editing a Contents Page without the need to 
manually update everything. 
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HOW TO CHANGE THE BACKGROUND OF A DOCUMENT 
 
If you have a Word document that you think looks a bit boring, there are a quite a few options 
available in Word to "jazz it up".  Below is a quick guide on how to change the background colour 
and effects. 
 
Select the Page Layout tab on the Ribbon, and go to the Page Background section, click on Page 
Colour and hover over a colour – the live preview means you can see what the page will look like 
before actually clicking on a colour. 
 

 
 
You can change the actual effects of the background too, by clicking on Fill Effects… 
 

 
 
This brings up a menu where you can select the shading styles / gradient of the colour… 
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…you can select the texture of the background, anything from denim to walnut… 
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…you can change the pattern of the background using the colours previously selected, or you can 
select new colours… 
 

 
 
…and if you don't actually want any of the pre-determined options, then you can download a picture 
of your own to use as a background image; click on Select Picture and navigate to the folder where 
your picture is saved. 
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It's all about personal preference and obviously what the document is being used for.  There are so 
many different variations that it's best to have a play around and find one that suits the document.  
Obviously this is just one way to spice it up! 
 
  



 

WORD TUTORIALS How To View Thumbnails Page | 37  
 

 

MS Word 2007 Tutorials | OutofhoursAdmin 

HOW TO VIEW THUMBNAILS 
 
Thumbnails are the smaller images of pages within the document you're currently working in.  
You're probably more familiar with them in PowerPoint as the "Normal" view has thumbnails down 
the left side next to the main slide you're working on. 
 
Well, the same applies to Word.  If you're working on a document several pages long and the 
thought of scrolling up & down pages drives you insane… then view the thumbnails. 
 
This is a very quick guide to show you how. 
 
So, firstly make sure you're on the View tab in the ribbon. 
 

 
 
In the Show/Hide section is the option Thumbnails – tick that box… 
 

 
 
…and you'll see thumbnail images down the left side of the main document, so you can go straight to 
the page you recognise without scrolling up & down – simple! 
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HOW TO CREATE LETTER HEADS USING WORD 
 
After I’d had my website and logo redesigned, I then thought about stationery.  Obviously I’d had 
business cards printed to incorporate the new design but what about headed paper, compliment 
slips etc.  All I really needed for my headed paper was my logo and company registration / contact 
details on the page, so I thought I’d try and save money & do my own stationery in Word. 
 
This step by step guide will show you how to create your own headed paper. 
 
So, firstly open up a blank Word document and go to Insert on the ribbon. 
 

 
 
In the Header & Footer section, click on Header.  Headers are generally used for documents such as 
tenders, books, proposals etc where you could have the title, page number, author at the top of 
every page.  In this case, I chose to use it to design my own headed paper.  If you have your logo 
saved as an image on your computer, you can choose to insert that into the header.  All you need to 
do is select Edit Header and it will bring up a blank header section. 
 

 
 
You’ll then notice that you’re in a new tab called Design under Header & Footer Tools, this is where 
you can make as many changes as you like to your header.  Click on Picture, and browse through 
your folders to where your image is saved, then click Insert. 
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Your picture will now appear in the header section, there will be another section appear at the top 
of the ribbon called Picture Tools, this is where you can format the picture (e.g. add a frame to it, 
rotate it, change the size, colour etc). 
 

 
 
The picture will automatically be positioned in the top left corner, if you want to move this, click on 
Home in the ribbon and choose the alignment you prefer.  For example, I prefer my logo to be in the 
top right corner, so I choose Align text Right in the Paragraph section of the Home tab.  It all 
depends on your own personal preference though. 
 

 
 
If you want to add text to your header with the picture, click on Insert and select Text Box, again you 
can choose one of the designs listed, or select Draw Text Box. 
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You can then type in your text and position the text box anywhere you like on the page / header.  
When you have finished, click on Close Header and Footer and the image/text will fade out slightly. 
 

 
 
If you don’t have a branded logo yet for your business, you can always use one of the designs shown 
in the Header section, all you will need to do is type in your own text.  Click on Insert, Header and 
choose a design that you like…. 
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Or you can insert a text box and input all the information you need, this can then be placed 
anywhere on the page, so you’re not only restricted to the header. 
 

 
 
Once the text box is inserted, you’ll see another option on the ribbon called Text Box Tools with 
Format underneath, this is where you can format your text box, change shape, colour, effects etc. 
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You can also change the position of the header in relation to the actual page, either by changing the 
measurements at the top of the page, or by dragging the ruler on the left hand side. 
 

 
 
Next, we move onto the Footer.  I usually use the footer to show my contact details – again it’s 
entirely up to you where you position everything, you may prefer your contact details to be in your 
header.  If you’re already in the header section, you can click on Go to Footer and it will 
automatically take you there. 
 

 
 
If not, then go to Insert on the ribbon and click on Footer and Edit Footer. 
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Type in all the details you want to include.  Remember, you can format the text by highlighting it, 
clicking on Home in the ribbon and selecting the necessary formatting e.g. bold, italic, font size, 
alignment etc. 
 

 
 
Once you’re happy with the details, click Close Header and Footer, and that’s it.  Now obviously 
there is so much more you can do with these options, so have a play around with them until you find 
something you really like. 
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HOW TO PRINT ADDRESSES ONTO ENVELOPES 
 
How many businesses spend time getting their letters, marketing information etc just right, only to 
put it in an envelope that has the address scrawled across the front looking like a doctor's 
handwriting (no offence to doctors, but you know what I mean)! 
 
This guide shows you how to print the recipients address on the front of the envelope, and also how 
to print a return address, to make it look a bit more professional.  I'm going to show you from 
scratch how to do one off envelopes. 
 
First things first, you need to open up a new document in Microsoft Word.  There are two ways of 
starting, you can either type out the recipient's address onto the document first… 
 

 
 
Or, you can enter the address at the next stage – it's entirely up to you. 
 
Click on Mailings on the Ribbon, and go to Envelopes in the Create section… 
 

 
 
This will bring up the Envelopes and Labels dialog box.  If you already typed out the address at the 
beginning, you'll notice that it's automatically added into the Delivery address section.  If you didn't 
type the address, you can now type it directly into the Delivery address box… 
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There's a handy preview showing you exactly what the envelope will look like.  There's also an 
option to include a return address.  If you want to add this, type out the address in the Return 
address section… 
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If you don't want to include a return address, tick the Omit box, and you'll notice that it disappears 
from the preview… 
 

 
 



 

WORD TUTORIALS How To Print Addresses Onto Envelopes Page | 47  
 

 

MS Word 2007 Tutorials | OutofhoursAdmin 

Next, you can change the font and style of the address, if you wish, by clicking on Options.  This will 
bring up another dialog box which allows you to select the envelope size, the position of the 
address, and the font.  Again, there is a handy preview for you to see the changes made… 
 

 
 
Clicking on Font for the delivery address and the return address (if applicable) allows you to change 
the colour, style, size and even the effect of the wording.  A preview is, once again, shown so you 
can see what it will look like.  Once done, click Okay and it will go back to the Envelope Options 
dialog box… 
 

 
 
Another option is the Character Spacing where you can choose the scale of the wording, how 
condensed you want the lettering to be, whether you want the wording raised/lowered etc… 
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The next option to look at is the Printing Options.  This will depend entirely on your printer set up as 
to whether you insert envelopes face up, face down, which tray to use etc… 
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Once you've chosen the right method for your printer, and you're happy with the envelope options, 
click Okay.  If you want to see the actual envelope on screen, click on Add to Document… 
 

 
 
…And the envelope appears on the screen 
 

 
 
If you don't want to see the envelope on full screen, then you don't have to add to the document, 
instead press Print as long as an envelope is loaded into the printer 
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HOW TO CHANGE ORIENTATION OF INDIVIDUAL PAGES 
 
A client asked me a good question recently; she had a Word document that was portrait and she 
wanted to change the orientation to landscape for one of the pages halfway through.  Sometimes a 
document needs to be both portrait and landscape, if it contains pictures or tables for example.  
Below is a quick guide on how to do this. 
 
We'll take my terms and conditions as the document.  At the moment it contains 3 pages of portrait 
orientation.  To start off we'll make the thumbnails visible so it's easier to see the separate pages. 
 

 
 
Let's say, for example, we want to insert a landscape page before page 3, how do we do that without 
changing the whole document? 
 
Firstly we need to insert a blank page, place the cursor at the beginning of the page where you want 
the new one to be – in this case we'll put the cursor at the beginning of page 3.  Then go to Insert on 
the ribbon and click Blank Page. 
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This will then insert a blank page before the page the cursor is on.  As you can see by the thumbnails, 
the new page is automatically the same orientation as the one before (portrait). 
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Changing the orientation of a page usually means going to Page Layout on the ribbon, clicking on 
orientation and selecting either portrait or landscape.  However, this won't work in this case as we 
only want to change 1 page and this method applies to the whole document. 
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To change 1 page we first place the cursor after the last word of page 2 then expand the Page Setup 
menu by clicking on the little arrow in the bottom right corner of the Page Setup section in the Page 
Layout tab on the ribbon. 
 

 
 
This opens up the Page Setup dialog box.  Make sure the Margins tab is selected and click Landscape 
under Orientation.  We can see the Preview at the bottom, it is still applying the changes to the 
whole document so we need to click on the drop down arrow next to Apply To, choose This point 
forward and click OK. 
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You'll see that page 3 has now changed to landscape, but so have the rest of the pages after it.  
Insert the picture, table or text that is going onto page 3 then place the cursor at the start of the 
next page and repeat the step above.  Open the dialog box in Page Setup, click Portrait, choose 
Apply to This point forward and click OK.  The rest of the pages should then go back to being 
portrait leaving you with just page 3 being landscape. 
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You can see from the thumbnail images if this has worked. 
 

 
 
And that's it – how to change the orientation of individual pages within the same document. 
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HOW TO CUSTOMISE BULLET POINTS 
 
Bullet points are a great way of catching the reader’s attention and also capturing the essential gist 
of a document, but you don’t have to stick with the standard black round “bullet” point.  There is a 
whole gallery of bullets which can be used to improve your document and show off a bit of 
creativity.  Below is a short guide on how to do that. 
 
Firstly, in the Home tab on the ribbon, go to the Paragraph section and click on the small drop down 
arrow to the right of the bullets icon… 
 

 
 
Click on Define New Bullet… 
 

 
 
Then click on Symbol to choose any symbol you like to get a new bullet… 
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If you don’t like any of those symbols, you can also select any from Webdings and Wingdings by 
clicking on the drop down arrow… 
 

 
 
Click on OK to set your new choice of bullet. 
 
You can also change the colour and size of the bullet (the same as you would text)… 
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Alternatively, instead of clicking on Symbol in the Define New Bullet dialog box, you can choose a 
picture from the large gallery… 
 

 
 
Type in what you are looking for, tick the box to include content from Office Online, and press Go… 
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Click on OK to add it the bullet library, or you can import it to an external file. 
 
And that’s it! The next time you’re putting together a presentation or document, try adding your 
own bullet to give it more of a unique feel. 
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HOW TO INSERT A PDF PAGE INTO A WORD DOCUMENT 
 
I was recently asked how to insert a pdf document into a Word document, so I thought I’d share this 
quick tip. 
 
Firstly in Word, place your cursor where you want the pdf document to go, click Insert on the ribbon, 
and click on Object (in the Text section)… 
 

 
 

Choose Adobe Acrobat Document and click OK… 
 

 
 
Go to where the pdf is located, and click Open, this will then insert the pdf page into your Word 
document.  You’ll notice that it’s covered in diagonal lines… 
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This is because the pdf document is open as well. As soon as you close the pdf file, the lines will 
disappear.  If you want to open the pdf at any time, double click on the page you inserted. 
 
A word of warning though, this only works for the first page of the pdf document, it will not insert 
more than the first page. Unfortunately it doesn’t look like Word has the capacity to insert more 
than the first page. One way around this is to take screenshots of the pdf pages and insert them as 
pictures, but this can be very time-consuming if you have lots of pages! 
 
Another way is to tick the box Display as icon in the Object dialog box, this will insert the PDF icon as 
a link within the document… 
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HOW TO SAVE & PASSWORD PROTECT A PDF DOCUMENT FROM WORD 
 
This quick tutorial is thanks to a question asked by a client last week, she had a Word document that 
she wanted to save as a pdf document but also wanted to password protect it and didn’t know how. 
 
Firstly click on Save As, which will open up the Save As dialog box, click on the drop down arrow 
under Save as type:, and choose PDF… 
 

 
 
Click on Options… 
 

 
 
This will open another dialog box, tick the box marked Encrypt the document with a password, and 
click OK… 
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Type in your password (twice) and click OK… 
 

 
 
Then click Save.  This should then automatically try to open the pdf file but will ask you for a 
password first… 
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Type in your password and it will then open the pdf file. 
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THANK YOU 

  
Thanks for downloading this free ebook – I hope you have found it useful and have learnt at least 
one little nugget of information! 
 
Unfortunately I won’t be adding any more tutorials for MS Word 2007, however please keep 
checking back on my blog for any other tutorials that might come in handy. 
 
If you find you need any help with MS Office, feel free to contact me via OutofhoursAdmin. 
 
Thanks again, 
 
 
 
 
 
 

Sharon 
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